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 مشخصات کلی پروژه -7-1

تنیکهدارایمقاطعغیر5متریباجرثقیل21یاسولهآنراداریمعبارتستازیسازمدلکهقصدیاپروژه

نظردازسازۀموریاهیاولیهانقشهباتکلا،ضرورتداردکهیسازمدل.پیشازشروعفرآیندباشدیممنشوری

باشندیمAutocadیهالیفاغالباًدرفرمتهانقشهبراساسآنانجامبگیرد.اینیسازمدلدردستباشدتا

دستینیزباشند.یهانقشهشاملخروجینرمافزارهاویاحتیتوانندیمودربرخیازموارد

ازنقشهباشد،یترشیبودرهرجاییکهنیازبهجزئیاتاست شدهادامۀاینبخشآوردهکلیسولهدریهانقشه

.گرددیمدرخلالهمانبخشمرتبطباآنارائه

ابعادهندسیسوله-2-7جدول

ابعادمشخصاتهندسی

متر21عرض

متر12طول

متر4.2ارتفاع

%12شیب

تن5جرثقیل





 

 پلانستونگذاریسوله-2-7شکل
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نمایجانبیسوله-1-7شکل





 

 
 بهجلویسولهنمایرو-3-7شکل
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 تکلا افزار نرمشروع کار با  -7-2

درمحیطویندوزکلیککنیدStartرویدکمۀر،بTekla Structuresافزارنرمیازانسخههرپسازنصب

ومسیرزیررابرایاجرایبرنامهطینمایید:

All Programs > Tekla Structures 16.0 > Tekla Structures 16.0  

Tekla Structures – Loginیامحاورهافزار،پنجرۀرویآیکوننرمرپسازطیمسیرفوقویاکلیکب

تنظیمنمایید.2-7یموجوددراینپنجرهراهمانندشکلهانهیگز،شودیمگشوده


پنجرۀتنظیماتاولیۀتکلا-2-7شکل


،واردمحیطاصلیبرنامهخواهیمشد.درابتدایکارنیازبهتعریفیکمدلجدیدداریمکهOKبافشردندکمۀ

:نمایید.برایایجاداینمدلجدید،مراحلزیرراطیکنیمسازیپروژۀخودرادرآنپیاده

.کلیکنماییدآیکونایندستوررویررااجراکنیدویاب…File > New(دستور2

تنظیمات1 سایر و آناختصاصدهید به مشخصیرا نام فایلپروژه، ذخیرۀ مشخصنمودنمسیر پساز )

بپذیرید.5-7فرضراهمانندشکلپیش

 یتولیدگردد.اهیاولکلیککنیدتایکمدلOKرویدکمۀر(درنهایتب3
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 تعریفیکمدلجدید-5-7شکل

 

 شبکه و تراز ارتفاعی مدلتنظیم خطوط  -7-3

.اینخطوطدرحکممبنایکارباشدیمییکسازه،تنظیممناسبخطوطشبکهسازمدلاولینگامبرایشروع

یهاشکلیاولیهداشتهباشند.خطوطشبکۀاینپروژهدرهانقشهوضرورتداردکهانطباقکاملیباباشندیم

 :اندشدهنشانداده7-7و7-6


خطوطشبکۀپلانمدل-6-7شکل
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 خطوطشبکۀترازارتفاعیمدل-7-7شکل

 

برایتنظیمخطوطشبکۀمدل،مراحلزیرراطینمایید:

فرضدابلکلیکرویخطوطشبکۀپیشررااجراکنیدویاب…Modeling > Create Grid(دستور2

نمایید.

تنظیماتزیرراانجامدهید:،Grid(درپنجرۀگشودهشدۀ1

رابصورتنسبیوطولترازY وXواقعدرراستایمحوریهادهانه،طولCoordinates(درکادر1-2

واقعدهانهکهطولکنید(.توجه7-7و6-7یهاشکل)براساسکنیددرجارتفاعیهرطبقهرابصورتمطلق

قرارگرفتهاست.A-1مختصاتدرآکسبدیندلیلکهمحورستاشدهبصورتمنفیدرجYراستایمحوردر




مثبتآنیهاجهتمحلقرارگیریمحورمختصاتو-4-7شکل



کنید.خطوطشبکهرامشخصیهابرچسب،Labels(درکادر1-1
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تنظیمخطوطشبکهایپنجرۀمحاوره-9-7شکل



3 کادر در )Other settings دUser-defined attributesدکمۀ و بفشارید شده،را گشوده پنجرۀ ر

ازلیستYesگزینۀ انتخابکنیدتاخطوطشبکهقفلگردندوبصورتتصادفیتغییرLockedیاکرکرهرا

ویاحذفنشوند.نکنند


قفلنمودنخطوطشبکه-22-7شکل



.کلیککنیدOKرویدکمۀرب Tekla Structures Grid(1)یامحاوره(درپنجرۀ2

کلیککنید.ModifyرویدکمۀربGrid(درپنجرۀ5

با،Modify(پسازفشردندکمۀ6 عملکردایناخطاررا پیاماخطاریازجانبتکلامواجهخواهیدشد، با

فرضگردند.بپذیریدتاخطوطشبکۀجدیدجایگزینخطوطشبکۀپیشYesفشردندکمۀ
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صلاحخطوطشبکهپیاماخطارتکلابههنگاما-22-7شکل


د،دستورواقعدرمسیرزیررااجراکنید:ناینکهخطوطشبکۀایجادشدهدرمحیطکاریقراربگیربهمنظور(7

View > Fit Work Area > To Entire Model in All Views  

یراانجامترقیدقعملیاتترسیمهاآنگرفتنازکمکباتوانیمواندشدهایجادنظردموراکنونخطوطشبکۀ

 داد.

ازجدولزیریگذارنامبهایننکتهتوجهداشتهباشیدکهیسازمدلپیشازشروع قطعاتمختلفاینپروژه

 تبعیتخواهدنمود.

قطعاتمختلفسولهیگذارنامنحوۀ-1-7جدول

قطعهاسمبلی
نوعقطعه

Start number Prefix Start number Prefix 

1 C 1 c ستون

1 RF 1 rf Rafter 

1 PU 1 pu )پرلین)لاپه

1 STR 1 str (کلافافقیStrut)

1 SA 1 sa (میلمهار(Sagrod 

1 BR 1 br (مهاربندBrace)

1 CR 1 cr تیرکرین

 

 ترسیم هندسۀ اعضا  -7-4

 غیر منشوری   ستون-7-4-1

شودیکقابدریکطرفسولهمدلاًکهصرفنیازاستمشابهیکدیگربودهوهاقاباغلبتمامیهاسولهدر

براییهامحلسپسبرحسبفواصلمختلفبهسایر سولهکهستوناولینیسازمدلموردنیازکپیگردد.

آوردهشدهاستمراحلزیرراطینمایید:21-7نقشهآندرشکل

رااجراکنیدودرپنجرۀ …View > Create View of Model > Along Grid lines(دستور2

نماهایمختلفدرامتدادخطوطOKوسپسCreateرویدکمۀریگشودهشدهبامحاوره کلیککنیدتا
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 < Create Viewرویخطوطشبکهواجرایدستوررشبکهایجادگردند.)ایندستورباراستکلیکنمودنب

Along Grid lines…باشدیمنیزقابلاجرا.) 

 
جزئیاتستونسوله-21-7شکل




ایجادنماهایمختلفدرامتدادخطوطشبکه-23-7شکل
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تاایننماگشودهشود.ددابلکلیککنیGrid 1برروینمای،View(درپنجرۀگشودهشدۀ1
 Tapered column 2ازکامپوننتGrid 1ونمایB(برایترسیمستونغیرمنشوریسولهدرآکس3

(S44)بدینمنظور:شودیماستفاده،

رااجراکردهوبررویکامپوننتDetailing > Component > Component catalog(دستور3-2

Tapered column 2 (S44)تااینکامپوننتاجراگردد.دکلیککنی


Tapered column 2 (S44)اجرایکامپوننت-22-7شکل


.شودبامشخصاتپیشفرضتولیدستونی)تیرورقی(تاددرترازصفرکلیککنیB(بررویآکس3-1

تنظیمPictureراهمانندشکلزیردرتبآنتولیدشدهدابلکلیککنیدومشخصاتستونبرروی(3-3

کنید:


Tapered column 2 (S44)کامپوننتPictureاصلاحمشخصاتتب-25-7شکل
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برایهاضخامتمشخصکنید.دقتداشتهباشیدکهاینابعادو،ابعادپلیتهایستونراParts(درتب3-2

.گرددیمدوپلیتبالودوپلیتجانبصورتجداگانهدرج


 Partsستوندرتبیهاورقتنظیمابعاد-26-7شکل

 

2 دستور توسط )Modeling > Add Points > At Any Position آکسمرکزییانقطه در را

(.27-7درشکل2ستونتولیدکنید)نقطۀ

مرحلۀ5 در تولیدشده نقطۀ )2 توسطدستور  بهمختصات…Edit > Copy Special > Linear را

و1،3،2تانقاط کپیکنید(250,6920-,0)، (0,152,7000)، (0,250,6510)، (0,250,6000)

 حاصلگردند.5

رافعالکنید.   Select objects in components(دکمۀانتخاب6

رابهعنوانخطبرشمعرفی1و2رااجراکنید.نقطۀDetailing > Cut Part > With line(دستور7

کنیدوسمتراستپلیتجانرابهعنوانسمتیکهقراراستبریدهشود.

تکرارکنیدتاورقجان5و2وهمچنیننقاط2و3براینقاط7(عملیاتبرشورقجانراهمانندمرحلۀ4

.گردد27-7همانندشکل
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ابعادهندسیورقجانونواحیبرشخورده-27-7شکل

 

ورقجانراتولیدتوانیمهمContour Plateلازمبهذکراستکهازطریقنقطهیابیواستفادهازدستور

نیزاستفادهکرد.Tapered column (S99)ازکامپوننتتوانیمکرد.همچنینبدینمنظور

بالدرقسمتفوقانیستونهمانندشکلزیریهاورقببریدتا5و3بالرادرنقاطیهاورق(طولاضافی9

گردند:


ستونبالیهاورقبرشطولاضافی-24-7شکل
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راستکلیککردهوتوسطدستور22 بررویگیرۀابتداییپلیتبال)درقسمتبرشخورده( )Moveگیرۀ

بهنقطۀ بررویآندابلکلیککردهودرتب2مربوطهرا )اگرموقعیتورقبالنامناسببود، انتقالدهید.

Positionچرخشورقرادرحالت،هایژگیوپنجرۀFrontرادرحالتآنوموقعیتBehind.)قراردهید













جابجاییگیرۀابتداییورقبالستوندرقسمتبرشخوردۀورقجان-29-7شکل

دقیقاًازآکسمرکزیBجابجاکنیدتاآکسYدرراستایمحورمتریلیم215(کلاجزایستونرابهمیزان22

ابتدایستونعبورکند.

 
 Bتنظیممحورمرکزیابتدایستونبررویآکس-12-7شکل

 

دابلکلیککنید.(بررویآیکونترسیمتیرفولادی21

12-7راهمانندشکلPositionرادرجکنیدوتبPL200*15وفیلدپروفیل،Attributes(درتب23

.تنظیمکنید

1 

B 

0.00 
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تنظیمموقعیتپلیتفوقانیستون-12-7شکل



 ترسیمکنید.5و2کردهوپلیتمربوطهرابیننقاطApplyرا23(تنظیماتمرحلۀ22

 
 Beamترسیمپلیتفوقانیستونتوسطدستور-11-7شکل



 ( Base Plate)صفحه ستون  -7-4-2

:گرددیممراحلزیرطیهاآنکهبرایترسیمباشندیم13-7اینپروژههمانندشکلیهاستونصفحه

 
دیتیلصفحهاتصالپایستون-13-7شکل



دابلکلیککنید.بررویآیکونترسیمستونفولادی(2

رادرجکنید.PL400*350(درفیلدپروفیل،1

ترازانتهاییرابرایترازابتداییوعددصفررابرای-12(عددPosition)واقعدرتبLevels(درکادر3

صفحهستوندرجکنید.

200 

200 

70 210 70 

PL400*350*20 

2ᵩ27 
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5 
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تنظیممشخصاتصفحهپایستون-12-7شکل


20*350*400درترازصفرکلیککنیدتاورقیبهابعادBرویآکسکردنتنظیمات،برApply(پساز2

تولیدگردد.

دابلکلیککنیدوتنظیماتزیر صفحهستون،بررویآیکونتولیدگروهپیچییهاسوراخ(برایترسیم5

گشودهشدهانجامدهید:یامحاورهرادرپنجرۀ


صفحهستون(یهاسوراخگروهپیچی)یامحاورهپنجرۀتنظیم-15-7شکل
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کردنتنظیمات،صفحهستونرابهعنوانقطعۀاصلیانتخابکنید.Apply(پساز5-2

فرعیانتخابکنید.(مجدداًصفحهستونرابهعنوانقطعۀ5-1

(دکمۀوسطموسرابفشارید.5-3

گروهپیچیرامعرفیکنید.X(مبدأوراستایمحور5-2

صفحهستون(راجابجاکنیدتادرنهایتشکلزیرحاصلگردد:یهاسوراخگروهپیچی)،(درصورتنیاز5-5


نماییازصفحهستونتولیدشده-16-7شکل



 استیفنرهای ستون  -7-4-3

ازهاآنقراردارندکهبرایترسیم6522و522،1522،5222،5522استیفنرهایافقیستونسولهدرترازهای

آوردهشدهوبه17-7استیفنرهادرشکلایندیتیل.شودیماستفادهStiffeners (1003)کامپوننتیبهنام

.شدهاستاشارهمراحلاستفادهازاینکامپوننتدرادامه

 
دیتیلاستیفنرهایافقیستون-17-7شکل



2 یانقطه( توسطدستور  Modeling > Add Points > At Any Positionرا مرکزیآکسدر

)درترازصفر(ابتدایستونایجادکنید.

کپیکنید.6522و522،1522،5222،5522بهترازهایCopy Linear(نقطهایجادشدهراتوسطدستور1

PL10 

Var 
10 

10 

10 

90 
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رااجراکنید.Detailing > Component > Component Catalog(دستور3

کامپوننت2 )Stiffeners (1003)  پنجرۀ در رویآندابلکلیککنید. بر و کرده جستجو یامحاورهرا

گشودهشده:

یاستیفنرچپوراست(درجکنید)براtرادرفیلدمتریلیم22ضخامتParts(درتب2-2

اندازۀپخاستیفنرهاراهمانندشکلزیرتنظیمکنید:Parameters(درتب2-1

 
تنظیمپخافقیوقائماستیفنرستون-14-7شکل



ابتداورقجانوسپسنقطۀایجادشده،1و2دربندکنیدودرنقاطایجادشدهOK(تنظیماتانجامشدهرا5

 Select objects in componentsدکمۀ،)دقتداشتهباشیدکهبرایترسیماستیفنرها.معرفیکنیدرا

فعالباشد(.

(اینمراحلرابرایترازهایذکرشدهنیزتکرارکنیدتاتمامیاستیفنرهایافقیتولیدگردند.6

هاجابجاکنید.Zدرراستایمنفیمحورمتریلیم5(درنهایتتمامیاستیفنرهارابهمیزان7


استیفنرهایتولیدشدهنماییاز-19-7شکل
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 )دستک( تکیه گاه جرثقیل -7-4-4

موقعیتکلیاولیهنیزیهانقشهکهدرباشدمیدارایجرثقیلمربوطهسولۀ،ذکرگردیدترشیپکهگونههمان 

 :باشدیمتنیاینسولهدارایدیتیلزیر5آنآوردهشدهاست.تکیهگاهجرثقیل


 دیتیلتکیهگاهجرثقیل-32-7شکل

 

کنید:مراحلزیرراطیاست،کهبهستونسولهمتصلتکیهگاهجرثقیلبرایترسیم

قراربگیرید.Grid1(درنمای2

رااجراکنید. Tapered beam (S98)(کامپوننت1

کامپوننت:یامحاوره(درپنجرۀ3

هایتیرورقتکیهگاهجرثقیلراتنظیمکنید:،ابعادهندسیپلیتParts(درتب3-2

 
تنظیمابعادهندسیپلیتهایتیرورق-32-7شکل

.،ارتفاعاولیهوثانویتیرورقراتنظیمکنیدParameters(درتب3-1

PL490*200*15 

PL250*200*15 

PL400*200*15 

PLA 
t=10 mm 

400 

250 

490 

500 

PLA 
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تنظیمارتفاعتیرورق-31-7شکل



(33-7درشکل2معرفیکنید.)نقطۀ5500+کردنتنظیمات،نقطۀاولترسیمرادرترازOK(پساز2

متریلیم222طولبهوYراازصفحهکلیدتایپکنیدتانقطۀدومدرراستایمحور0,400,0(مختصات5

قراربگیرد.


1و2ترسیمتیرورقتکیهگاهجرثقیلبامعرفینقاط-33-7شکل



راازنوارابزارانتخابفعالکنید.  Select objects in componentsدکمۀ(6

کنید.Move(بررویورقجانکلیککنیدوگیرۀپایینیآنرانسبتبهپلیتموربستونسوله7

رابرایورقبالپایینیتیرورقنیزانجامدهید.7(عملیاتمرحلۀ4

ترسیم9 دستور از استفاده با Beamتیرفولادی)( ابعاد ورقیبه ،)PL200*15انتهایتیرورقترسیم در

(32-7درشکل1و2کنید.)بامعرفینقاط

1 2 
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1و2ترسیمورقانتهاییتیرورقتکیهگاهجرثقیلبامعرفینقاط-32-7شکل



 تیر کانتیلور -7-4-5

کهارتفاعاولیهآنشودیماستفادهTapered beam 2 (S45)ازکامپوننتسولهبرایترسیمتیرکانتیلور

 درنظرگرفتهشدهاست.متریلیم222وارتفاعانتهاییآن172

 
دیتیلتیرکانتیلور-35-7شکل

 

مراحلزیرراطینمایید:ترسیماینتیروورقاتصالآن،برای

قراربگیرید.Grid 1(درنمای2

(بررویآیکونترسیمتیرفولادیدابلکلیککنید.1

 Applyرادرجکنید.سایرتنظیماتلازمرانیزانجامدادهوبررویدکمۀPL150*10(درفیلدپروفیل،3

کلیککنید.

 350-,0,0(ونقطۀدومرابصورتمختصاتی36-7درشکل2(نقطۀاولرادرانتهایپلیتبالستون)نقطۀ2

ازصفحهکلیدتایپکنیدتاپلیتاتصالتیرکانتیلورترسیمگردد.

PLA 

PL100*10 

PL100*10 

P
L

3
5

0
*
1

5
0
*

1
0

 

100 

850 

2
7
0

 
PLA t=8 
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ترسیمورقاتصالتیرکانتیلورنحوۀ-36-7شکل


رااجراکنید. Tapered beam 2 (S45)،کامپوننتبرایترسیمتیرکانتیلور(5

کامپوننت:یامحاوره(درپنجرۀ6

،ارتفاعاولیهوثانویهتیرغیرمنشوریراتعیینکنید.Picture(درتب6-2

 
کانتیلورتنظیمارتفاعاولیهوثانویتیر-37-7شکل


،ابعادهندسیپلیتهایتیررامشخصکنید.Parts(درتب6-1

 
تنظیمابعادهندسیپلیتها-34-7شکل

معرفیکنید.2(نقطۀاولرادرگوشۀبالاییورقترسیمشدهدربند7

1 
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ازصفحهکلیدتایپکنید.170-,850-,0(نقطۀدومرابصورتمختصاتی4

هاجابجاکنید.Zدرراستایمنفیمحورمتریلیم32همیزان(تیرتولیدشدهراب9


نماییازتیرتولیدشده-39-7شکل

 

  Rafterهای اتصال فلنجی ستون به  پلیت -7-4-6

ایندوگرددیماستفادهPL540*200*15ازدوپلیتاتصالبهابعادRafterبرایاتصالستونبه ابتدا .

وشوندیمیسازمدلهاRafterسپسگردندیمترسیم )درراستایمایل(Beamتوسطدستورترسیمیپلیت

کهدراندشده.ایندوپلیتاتصالبامعرفیدونقطهترسیمگرددیماتصالفلنجیکاملهاآنیسازمدلپساز

اشارهشدهاست:هاآنادامهبهمراحلتولید

نید.(بررویآیکونترسیمتیرفلزیدابلکلیکک2

رابفشارید. Applyرادرجکنید.سایرتنظیماتلازمراانجامدادهودکمۀPL200*15(درفیلدپروفیل،1

(22-7درشکل2)نقطۀ(نقطۀاولرادرلبۀبالاییورقبالستونمعرفیکنید.3

درراستایمورببالایستونقرارگرفتهوعدد،Snapوباکمکگرفتنازعملیات(توسطنشانگرموس2

 ترسیمگردد.متریلیم522طولبهراتایپکنیدتاورقموربیدرراستایمعرفیشده522


نحوۀترسیمپلیتاتصالفلنجی-22-7شکل

راستایمورب

2
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رااجراکنید.Copy(بررویورقترسیمشدهراستکلیککردهودستور5

(نقطۀاولودومجابجاییراهمانندشکلزیرمعرفیکنیدتاپلیتموربدیگریتولیدگردد.6


نحوۀکپیکردنپلیتاتصال-22-7شکل



ترسیمشد بدینجایکار تا نامیاقهیسلبصورت.گردندیمندبهعنواناسمبلیستونمحسوباهقطعاتیکه

 .میکنیمتنظیمAssemblyبرایCوحرفPartبرایcرابررویحرفهاآن(تمامیPrefixپیشوند)

:گرددیمبیناینقطعاتهممراحلزیرطیبرایایجاداسمبلیما

دابلکلیککنید. (بررویآیکونتولیدجوش2

(ورقجانستونرابهعنوانقطعهاصلیمعرفیکنید.1

،کلیهملحقاتستونراانتخابکنیدتابهقطعۀگرددیم(توسطیکمستطیلانتخابکهبادرگکردنایجاد3

ورقاتصالفلنجیمتصلبهستونجزءتولیدگردد.دقتداشتهباشیدکهتنهاستوناصلیجوششوندواسمبلی

.گرددیماسمبلیستونمحسوب

استفادهکنید. Select assembliesدشدهازآیکونبرایبررسیوکنترلاسمبلیتولی(2



  Rafterترسیم -7-4-7

ازکامپوننتRafterبرایترسیم گرددیماستفاده Tapered beam 2 (S45)ها هایRafterدیتیل.

نشاندادهشدهاست.21-7سولهدرشکل

 

2 1
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 سوله Rafterدیتیل-21-7شکل

 

:شودیمنحوۀکارطیمراحلزیرانجام

قراربگیرید.Grid 1درنمای(2

رااجراکنید. Tapered beam 2 (S45)(کامپوننت1

کامپوننت:یامحاورهدرپنجرۀ (3

دهید:،تنظیماتزیرراانجامPicture(درتب3-2


 Pictureتنظیماتتب-23-7شکل



 کنید.ApplyرامشخصکنیدوتنظیماتانجامشدهراRafterهای،ابعادهندسیپلیتParts(درتب3-1

2000 

3791 
250 

500 

PL8 

PL8 

PL200*15 

PL200*15 
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 Partsتنظیماتتب-22-7شکل


(نقطۀاولرادرگوشۀپلیتاتصالتولیدشدهدربخشقبلمعرفیکنید.2

راازصفحهکلیدتایپکنید.0,2000,0مختصات،(برایمعرفینقطۀدوم5

راکمیدرراستایموربجابجاکنیدتادرمرکزپلیتاتصالقراربگیرد.Rafter(درصورتنیاز6


سولهRafterترسیم-25-7شکل



نیزهمانندمراحلبالاعملکنیدبااینتفاوتکهاینبارارتفاعاولیهوثانویRafterدومتکهبرایترسیم

گردد.متریلیم152تیرورقبایستییکسانوبرابر

وانتهایاضافیتوسطدستوررسدیممتری(6دقیقاًتاوسطدهانۀسوله)Rafterلازمبهذکراستکهانتهای

Detailing > Cut part > With Line شودیمبریده فوقانی ورق همچنین .Rafterبایستی نیز

ازنوارابزارانتخابSelect objects in componentsبصورتیکتکهمدلگرددکهبدینمنظوردکمۀ

.گرددیماستفادهEdit > Combineفعالشدهوازدستور



 اتصال فلنجی  -7-4-8

بخش 6-2-7در تولید نحوۀ اینبخشگردید،اشارهاتصالفلنجییهاورقبه ایناتصالرامیخواهیمدر

 تولیدشدهایجادکنیم.یهاورقمابین

 Rafterتکهاول

 Rafterتکهدوم

ی
کز
مر
ط
خ
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 Rafterدیتیلاتصالفلنجیبینستونو-26-7شکل

 

:دبرایایجادایناتصالپیچیمراحلزیرراطیکنی

کلیکدویابررویآیکونایندستوررااجراکنیDetailing > Bolts > Create Bolts(دستور2

کنید.

.د(ورقاولرابهعنوانعضواصلیمعرفیکنی1

.د(ورقدومرابهعنوانعضوفرعیمعرفیکنی3

گیرۀابتداییوانتهاییورقاولتعیینکنید.نرانیزبامعرفیآوراستایهاچیپ(مبدأگروه2

هاآنبررویشانیریقرارگبرایاصلاحقطرونحوۀ،اندشدهپیشفرضتولیدیهایژگیوباییهاچیپ(اکنون5

.ددابلکلیککنی

د:راهمانندشکلزیرتنظیمکنیهاآنقراردادهوتعداد12رویعددررابهاچیپ(قطر6


اتصالفلنجییهاچیپتعدادتنظیم-27-7شکل



جابجاکنید.رراستایموربدمتریلیم72تولیدشدهرابهمیزانیهاچیپ(7

50 50 100 

70 

70 

4*100 
540 

PL540*200*15 

1/2PL150*90*10 

10ᵩ20 
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برایترسیماستیفنرهایاتصال:

(بررویآیکونتیرفلزیدابلکلیککنید.2

رادرجکنید.PL90*10(درفیلدپروفیل،1

رابفشارید.Apply(سایرتنظیماتلازمراانجامدادهودکمۀ3

(.24-7درشکل2(نقطۀاولرادرگوشۀورقاتصالمعرفیکنید)نقطۀ2

 
معرفیدونقطهبرایترسیماستیفنر-24-7شکل



راازصفحهکلیدتایپکنید.252قرارگرفتهوعددگوشۀورقSnap(درراستای5

ازسایرنماها،آندرراستایورقاتصالجابجاکنیدوبابررسیمتریلیم212(استیفنرتولیدشدهرابهمیزان6

رابرطرفکنید.Rafterایجادشدهبایهاتداخل

را Create view > Default views of partبررویاستیفنرتولیدشدهراستکلیککردهودستور(7

اجراکنید.

توسطدستور Part top view(درنمای4  < Detailing > Cut partقراربگیریدوورقمستطیلیرا

With lineببریدتاتبدیلبهورقمثلثیگردد.)بامعرفیدونقطه(ازنقاطگوشه

به(9 تغییریمتریلیم222یهافاصلهاستیفنرمثلثیتولیدشدهرا درراستایورقاتصالموربکپیکنید)با

.عملیاتکپیکردنراانجامداد(توانیمسیستممختصاتمحلینیز

بهسمتچپنیزCopy Special > Mirrorنهایتتمامیاستیفنرهایتولیدشدهراتوسطدستور (در22

 حاصلگردد.29-7کپیکنیدتاشکل

2  Snap راستای
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نماییازاتصالتولیدشده-29-7شکل



شاملRafterرانیزبهکمکجوشایجادکنید.دقتداشتهباشیدکهاسمبلیRafterدراینمرحلهاسمبلی

)صرفاًدرسمتاتصال(.باشدیمورقاتصالفلنجیواستیفنرهایمثلثینیز

راقطعات،آکسدهانهنیتریانیمازاًدقیقتوانیم،شدیسازمدلکاملطوربهسولهۀپسازاینکهنیمیازدهان

کپینمود.برایانجاماینعملیات:بهسمتدیگرسوله

کلیۀاعضای2 باشیدکهخطوطبرشقطعاتغیرمنشورینیزیسازمدل( انتخابکنید)دقتداشته را شده

بایستیانتخابشوند(.

رااجراکنید.Edit > Copy Special > Mirror(دستور1

قراربگیرید.Plan 0.00(درنمای3

پیگردند.معرفیکنیدتاکلیۀملحقاتبهسمتدیگرسولهکBوA(نقطۀاولودومرابینآکس2

استکهدهانۀکاملسولهبهفواصل نیاز اینمرحله، انجام کلیۀ6پساز برایاینمنظور متریکپیشود.

 و انتخابنموده را فواصل2اعضایدهانه به کپی یمتریلیم6222عدد  Edit > Copyتوسطدستور

Special > Linear.خواهدبود52-7کارهمانندشکلنتیجۀایجادکنید.
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مشابهسولهیهادهانهنماییاز-52-7شکل

 
نماییمهنگامیکهقصدکپیکردنتعدادزیادیازقطعاتراداریم،بهتراستکهقطعاترابصورتاسمبلیکپی

تادیگرمجبورنباشیممجدداًبرایقطعاتکپیشدهاسمبلیتولیدکنیم.



 (Strutکلاف افقی ) -7-4-9

یهالیپروفاینکهتمامیلیدلبه.باشدیم4*100کلافافقیاستفادهشدهدراینپروژهازنوعقوطیوبهابعاد

مربوطهکپییهاتیموقعشودودرسایریسازمدلهاآنکافیستیکیازصرفاً،باشندیمکلافافقییکسان

 گردد.


 دیتیلکلافافقیسوله-52-7شکل

5754 
8 8 8 8 

103 103 

RHS100*4 

A 

A 

30 30 

30 

30 

140 

140 

PL200*200*8 

RHS100*4 

4ᵩ20 

Sec A-A 
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:دبرایترسیمکلافافقیواتصالانتهاییآن،مراحلزیرراطیکنی

قراربگیرید.Grid 1(درنمای2

ایجادکنید.Bآکسترازصفردر توسطآیکونرایانقطه(1

 
 Bایجادنقطهدرترازصفرآکس-51-7شکل

 

درراستایمحورمتریلیم6742بهمیزانCopy Special > Linear(نقطهایجادشدهراتوسطدستور3

Z.کپیکنید

(بررویآیکونترسیمتیرفلزیدابلکلیککنید.2

:Beam Propertiesیامحاوره(درپنجرۀ5

رادرجکنید.RHS100*4درفیلدپروفیل،(5-2

راهمانندشکلزیراصلاحکنید:Position(تنظیماتتب5-1

 
 Positionتنظیماتتب-53-7شکل



کنید.Apply(تنظیماتانجامشدهرا5-3

تیرمعرفیکنید.تولیدشد،بهعنواننقطۀاولیه3مرحلهراکهدریانقطه(6
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راازصفحهکلیدتایپکنید.6000,0,0(برایمعرفینقطۀدوم،مختصات7

گردد.برایانجاماینیسازمدل(آننیزEnd Plateپسازترسیمکلافافقی،نیازاستکهاتصالانتهایی)

کارمراحلزیرراطینمایید:

درانتهایکلافافقیتولیدکنید.)بادقتدرربایشنقطه( راتوسطآیکونیانقطه(2

1 توسطدستور را شده تولید نقطه )Copy Special > Linear میزان 223به ،229 ،5473 5449و

هاکپیکنید.Xدرراستایمحورمتریلیم

 5449و5473وهمچنین229و223راکهواقعدربیننقاطیاقطعهدو Edit > Split(توسطدستور3

راحذفنمایید.هاآنهستندرابریدهوسپس


اتصالیهاورقبرشابتداییوانتهاییکلافافقیبرایترسیم-52-7شکل



کپیمتریلیم4بهمیزانXراترسیمنماییدودرراستای8*200*200(درناحیۀبریدهشده،ورقیبهابعاد2

درانتهایآن(کنیدتادوورقچسبیدهبههمتولیدگردد.)همدرابتدایکلافافقیوهم


انتهاییکلافافقییهاورق-55-7شکل



 Teklastructures.ir                                                                      تخصصی تکلا سایت

 

انتهاییایجادیهاورقمابین52-7موجوددرشکلعددپیچبامشخصات2(توسطآیکونتولیدگروهپیچی،5

 کنید.

وتعدادمتریلیم6222(پسازتکمیلاتصالابتداییوانتهاییکلافافقی،کلجزئیاتمدلشدهرابهمیزان6

.دکپیکنیXعدد،درراستایمحور3

.دهاکپیکنیZدرراستایمنفیمحورمتریلیم 1732افقیتولیدشدهرابهمیزانیهاکلاف(کلیۀ7

بهسمتدیگرسولهکپیCopy Special > Mirrorهردوترازراتوسطدستوریهاکلاف(درنهایت4

.دکنی

 
(Strut)افقیسولهیهاکلافتکمیل-56-7شکل



ابتداوانتهایآنجزءیهاورقدقتداریمکهتکۀمیانیکلافبههمراه،افقییهاکلافبرایایجاداسمبلی

 و یهاتکهاسمبلیکلافمحسوبشده همراه به یهاورقکناری به شده ستونهاآنمتصل اسمبلی جزء

.گردندیممحسوب



 )شاه تیر جرثقیل یا تیر کرین( تیر باربر ریل -7-4-11

وورق PL240*15کهازنوعتیرورقبودهودارایابعادبالشودیمجرثقیلسولهتیریمدلگاهتکیهبرروی

 آوردهشدهاست.57-7دیتیلاینتیرباربردرشکل.باشدیمPL300*8جان
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دیتیلتیرباربر-57-7شکل

 

:دطولیآنمراحلزیرراطیکنییهاکنندهبرایترسیماینتیرورقوسخت

.درااجراکنی Detailing > Component > Component Catalogدستور(2

تااجراشود.دراجستجوکردهوبررویآندابلکلیککنیTapered beam (S98)(کامپوننت1

اصلاحکنید:همانندشکلزیرابعادتیرورقرا،Parts(درتب3


تیرهندسیابعادتنظیم-54-7شکل



.دنراتنظیمکنیآارتفاعتیرورقونوعقرارگیریابتداوانتهایParameters(درتب2

 

1198 1200 1198 1200 1200 

PL5996*240*15 (Flange) 

PL5996*240*15 (Flange) 

PL5996*300*8 (Web) PL300*110*10(Stiffener) 

Det A 

50 50 50 50 

50 

50 

150 

100 

PL300*250*8 

Det A 
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ارتفاعوموقعیتابتداوانتهایتیرورقتنظیم-59-7شکل


 .دکنیایجادجرثقیلگاهمرکزتکیهتیرورقیرابیندوهایژگیوکلیککردهوبااینOK(بررویدکمۀ5


نماییازتیرباربرتولیدشده-62-7شکل



کپیکنید.Xدرراستایمحورمتریلیم6222(تیرورقتولیدشدهرابهمیزان6

نیزباکمکدستورتولیدجوشتکمیلشانیهایاسمبلوشدندیسازمدلاولیه)تیرباربر(ازاینکهدوتیرورقپس

کپیگردد.برایهاتیموقعجانتیرورقهانیزتکمیلشدهوبهسایریهاورقنیازاستکهاتصالبین،گردید

ترسیماتصالبینتیرورقهامراحلزیرراطیکنید:

انتهاییبرایآنایجادکنید.Offsetمتریلیم1(بررویتیرورقاولیهدابلکلیککردهومقدار2
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انتهاییتیرورقاولOffsetمقدار-62-7شکل



1 برایتیرورقکپیشده همینعملیاترا ) نیز اینتفاوتکه با دهید. فقطدر،اینتیرورقOffsetانجام

ابتدایآناعمالخواهدشد.

3 دستور و کرده کلیک راست اول تیرورق روی بر )Create View > Default views of 

Component.رااجراکنید

بیندوتیرورقراPL300*250*8قراربگیریدوورقیبهابعادComponent front view(درنمای2

ترسیمکنید.

وبهسمتدیگرجاننیزکپیکنید.همانندشکلزیر:(موقعیتورقراتنظیم5

 

 

 

 

 

 

جاناتصالیهاورقترسیموتنظیمموقعیت-61-7شکل

 

(بررویآیکونتولیدگروهپیچیدابلکلیککنید.6

OKبررویدکمۀسپستنظیمکنید.63-7راهمانندشکلهاآنوموقعیت12رابررویعددهاچیپقطر(7

کلیککنید.
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هاچیپتنظیمفواصلقرارگیری-63-7شکل



عددپیچتولید2رامعرفیکنیدتاXوراستایمحوراتصالیهاورق(ابتداورقجانتیرورقاولوسپس4

رااصلاحکنید.هاچیپگردد.درصورتنیازموقعیت

(عملیاتمذکوررابرایتیرورقدومنیزتکرارکنیدتادرنهایتدونوعگروهپیچیمجزابرایهردوتیرورق9

تولیدگردد.

 
اتصالپیچیتولیدشدهبیندوتیرورق-62-7شکل



طولیتیرورق:یهاکنندهبرایترسیمسخت

رااجراکنید.Detailing > Component > Component catalog(دستور2

دابلکلیککنید.Multiple Stiffeners (1064)(بررویکامپوننت1

راتنظیمکنید.هاکننده،تعدادوفواصلسختPicture(درتب3
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 طولییهاکنندهتنظیمتعدادوفواصلبینسخت-65-7شکل


رامشخصکنید.هاکننده،ضخامتوعرضسختParts(درتب2

 
 هاکنندهتنظیمضخامتوعرضسخت-66-7شکل



رااصلاحکنید.هاکننده،کلاسسختGeneral(درتب5

راOKسپسدکمۀقراردهید.متریلیم22،میزانپخگوشۀاستیفنررابررویعددStiffeners(درتب6

بفشارید.


هاکنندهتنظیممیزانپخسخت-67-7شکل



انتخابفعالکنید.راازنوارابزار   Select objects in componentsدکمۀ(7

تولیدگردند.هاکنندهرادرمرکزجانتیرورقاولمعرفیکنیدتاسختیانقطه(4
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(عملیاتمذکوررابرایتیرورقدومنیزتکرارکنید.9

راباجزئیاتمدلشده،درهاآنواتصالاتمربوطه،نیازاستکه)اسمبلی(پسازتکمیلدوتیرورقباجزئیات

برایCopy Special > Mirrorکپیکردهوسپسازدستورمتریلیم21222بهطولXراستایمحور

کپیکردنبهسمتدیگرسولهاستفادهکنید.

 

 سولهاتصال فلنجی تاج  -7-4-11

)تاجسوله(نیازاستکهاتصالفلنجیمناسبیهمانندشکلرسندیمسولهبهیکدیگرRafterدرمحلیکهدو

گردد:یسازمدلزیر

 
دیتیلاتصالفلنجیتاجسوله-64-7شکل

 

اتصالتاجسولهمراحلزیرراطیکنید:یسازمدلبرای

قراربگیرید.Grid 1(درنمای2

راستوچپسولهرادرتاجسولههرRafterخطوطبرشMove Special > Linear(توسطدستور1

یکدیگرجابجاکنید.جهتدرخلافمتریلیم25یکبهمیزان

50 50 100 

70 

130 

120 

30 

6ᵩ20 

PL350*200*15 
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 درتاجسولهیمتریلیم32ایجادفاصلۀخالی-69-7شکل



هاایجادکنید.RafterرامابینPL350*200*15(توسطدستورتولیدتیرفلزی،پلیتیبهابعاد3

کنید.کپیYدرراستایمحورمتریلیم25(پلیتتولیدشدهرابهمیزان2

نقطهترسیمکنید.سپسآنرابهسمت3استیفنرمثلثیشکلیرابامعرفیContour Plateتوسطدستور(5

(.باشدیممتریلیم4)ضخامتپلیت دیگرتاجسولهکپیکنید.


نقطه3ترسیماستیفنرمثلثیشکلبامعرفی-72-7شکل


رویآیکونتولیدگروهپیچیدابلکلیککنید.(بر6

راهمانندشکلزیراصلاحکنید:هاآنتنظیمکردهوفواصل12رابررویعددهاچیپ(قطر7


هاچیپتنظیمفواصلقرارگیری-72-7شکل

15 

1 

2 

3 

15 
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،همانندمطالبپیشینگروهپیچیراتولیدونسبتبهموقعیتمناسبجابجاApply(پسازفشردندکمۀ4

کنید.

 
اتصالفلنجیتاجسوله-71-7شکل



 )لاپه(پرلین  -7-4-12

 درشکلزیرآوردهشدهاست:هاآندیتیلمربوطبهکهباشندیمشکلZهایسولهازنوعپروفیلپرلین

 
 هایسولهدیتیلپرلین-73-7شکل

470 1528 2000 1528 470 

5996 

470 1528 2000 1528 1472 

6998 

40 

40 

100 

40 

40 

100 

 هایمیانیالف(دیتیلپرلین

 کناریهای(دیتیلپرلینب

Z180*60*3 

Z180*60*3 
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هامراحلزیرراطینمایید:برایترسیمپرلین

بررویآیکونترسیمتیرفلزیدابلکلیککنید.(2

رادرجکنید.Z180*60*3(درفیلدپروفیل،1

رابفشارید.Applyراانجامدادهودکمۀتنظیماتسایر(3

بصورت2 ونقطۀدومرا انتهایتیرکانتیلوردهانهدوم، در نقطۀاولرا مقطع 6998,0,0-(  Zدرجکنیدتا

تولیدگردد.متریلیم6994شکلیبهطول

 
پرلینتولیدشدهنماییاز-72-7شکل



هاسوراخ.محلقرارگیریاینکنندیمعبورهاآنهستندکهمیلمهارهاازییهاسوراخهایترسیمیدارایپرلین

:شودیممراحلزیرطیهاآنبرایایجادکهمشخصشدهاست73-7شکلدر

 Create view > Default views of parts(بررویپرلینترسیمشدهراستکلیککردهودستور2

.درااجراکنی

.دقرارگرفتهوسایرنماهارابندیPart front view(درنمای1

75-7آنراهمانندشکلیامحاورهپنجرۀیهایژگیو ورده(بررویآیکونتولیدگروهپیچیدابلکلیکک3

تنظیمکنید:

 پرلین

 تیرکانتیلوردهانهدوم

 تیرکانتیلوردهانهاول
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پرلینیهاسوراختنظیممحلقرارگیری-75-7شکل


تادکنیمحورمرکزیپرلینتعریفرانیزازXبامعرفیپرلینبهعنوانقطعهاصلیوفرعی،راستایمحور(2

بافواصلمشخصتولیدگردند.ییهاسوراخ

اضافیرابصورتمجزاحذفیهاسوراخ بااستفادهازآیکونراجابجانمودهوهاسوراخدرصورتنیاز(5

.کنید

6) نیازاستکهنحوۀقرارگیریرندیگیمهادرسطوحشیبدارقرارتوجهبهاینکهپرلینبا نیزبررویهاآن،

پرلینوRotationوفیلدPositionرادرتب11.309درصدتنظیمشدهباشد.بدینمنظورزاویه12شیب

د.نشیبدارگردایناجزاتادرجکنیدهاسوراخ

ترکوتاههایمیانیکهطولپرلیناشتهباشید.فقطدقتددهمانندروشبالاتولیدکنینیزهایمیانیراپرلین(7

هایکناریاست.ازطولپرلین

شود.یسازمدل76-7نیزهمانندشکلهاآننیازاستکهاتصالاتمابین،هاپسازترسیمپرلین
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هادیتیلاتصالبینپرلین-76-7شکل

 

:دهامراحلزیرراطیکنیبرایترسیماتصالبینپرلین

پرلین2 برروییکیاز راستکلیککردهوتوسطدستور(  Create view > Default views ofها

partبهنمایPart end view روید.ب

بررویآیکونترسیمتیرفلزیدابلکلیککنید.(1

رادرجکنید. PL100*10(درفیلدپروفیل،3

رابفشارید.Apply(سایرتنظیماتراانجامدادهودکمۀ2

درامتدادبالفوقانیتیرکانتیلور(نقطهاولرادرمحلتقاطع5 پرلینبهطولSnapوپرلینونقطهدومرا

.دیمعرفیکن272

 

20 20 60 

35 

35 

100 

140 

10 

10 80 

PLA 
PLB 

1/2PL150*90*10 

PL170*100*10 

4ᵩ12 

Rafter 

Purlin 

PLA 

PLB 



 Teklastructures.ir                                                                      تخصصی تکلا سایت

 

 < Cut partنراتوسطدستورآتولیدکردهوPL150*90*10(بههمینروشورقدیگریرابهابعاد6

With Lineدبهدونیمتقسیمکنی.

 
هااتصالبینپرلینیهاورقایجاد-77-7شکل



.درنهایتشکلدازیکدیگرراایجادکنیمتریلیم62دوردیفپیچبهفاصله،Create boltsتوسطدستور(7

همانندشکلزیرخواهدبود:تولیدشدهاتصال

 
هانماییازاتصالنهاییبینپرلین-74-7شکل

.دکپیکنیهاتیموقعهارابهسایرهاییکجهت)بررویتیرکانتیلور(،اینپرلین(پسازتولیدکاملپرلین4

(.Rafter)درراستاییمتریلیم2222پرلینبهفاصله6وسپسیمتریلیم912ابتدادرفاصله

لازمبهذکربهسمتدیگرقابسولهکپیکنید.Mirrorتوسطدستورهاییکسمتراپرلیندرنهایت(9

.رندیگیمقرارRafterدرقالباسمبلیهاپرلیناتصالیهاورقاستکه
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 (Sagrod) میل مهارها -7-4-13

 بخشقبلیتمامیپرلیندر همراه به را اکنونییهاسوراخها کردیم، میانشانایجاد مابیناینمیخواهیمدر

به79-7شکلیهانقشهاستفادهکنیم.هریکازمیلمهارهابرطبقمتریلیم22ازمیلمهاربهقطرهاسوراخ

اینمقداررالحاظخواهیمنمود.یسازمدلکهدراندزدههابیرونازپرلینمتریلیم22میزان


دیتیلاتصالمیلمهاربهپرلین-79-7شکل


:دبرایترسیممیلمهارهامراحلزیرراطیکنی

.دقراردهیD14دابلکلیکنمودهونوعپروفیلرابررویBeam(بررویآیکون2

.ددرجکنیDxرادرفیلد40-و40اعدادOffset(دربخش1

3 پساز )Applyانتهای،کردنتنظیمات و ابتدا معرفینقطۀ با دریهاسوراخمیلمهاریرا گرفته قرار

.دروبرویهمترسیمکنی

وبرایبالارفتنسرعتکارازعملیاتکپیکردناستفادهاده(اینفرآیندرابرایسایرمیلمهارهانیزانجامد2

.دکنی

 
مهارتولیدشدهمیلنماییاز-42-7شکل

 بندهای افقی رترسیم مها -7-4-14

یهادهانهمهاربندهایافقیدراینبطوریکه،باشندیممتریلیم12وبهقطرمهاربندهایاینسولهازنوعمیلگرد

.اندشدهسولهبهکاربردهآخرکناریاولو

ᵩ14 

ᵩ14 
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:دبرایترسیممهاربندهایافقیمراحلزیرراطیکنی

قراربگیرید.Grid Aنمایدر(2

توسطآیکون1 ) Add points at any position یانقطه، ترازصفرآکسمرکزیرا تولید1در

کنید.

 
 1ایجادنقطهدرآکس-42-7شکل

 

رااجراکنیدتاپنجرۀCopy Special > Linear(برروینقطۀایجادشدهراستکلیککردهودستور3

گشودهشود:Copy-Linearیامحاوره

کلیککنید.Copyراتایپکردهوبررویدکمۀ322عددDz(ابتدادرفیلد3-2

کلیککنید.Copyراتایپکردهوبررویدکمۀ3752عددDz(درفیلد3-1

کلیککنید.Copyسپسبررویدکمۀ322عددDzراتایپکردهودرفیلد6222عددDx(درفیلد3-3

کلیککنید.Copyسپسبررویدکمۀ3752عددDzراتایپکردهودرفیلد6222عددDx(درفیلد3-2

آنگشودهشود.یامحاورهتاپنجرهددابلکلیککنیفلزی(بررویآیکونترسیمتیر2

 -22و22آنراهمانندبخشقبلیبررویدوعددOffsetودتنظیمکنیD20رابررویمهاربند(پروفیل5

.دقراردهی

 
پروفیلمهاربندOffsetتنظیممقدار-41-7شکل
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.دکردنتنظیمات،تیریرامابینهردونقطهتولیدشدهبصورتضربدریترسیمکنیApply(پساز6

 
مهاربندتولیدشدهدردهانهاول-43-7شکل



سوراخایجادگردد.برایایجادهاستون(برایاینکهمیلگردهاازدرونستونسولهعبورکنندبایستیدرمیان7

رویهاسوراخ پلیتکلیککنید،Create part cutآیکونبر منشوریجانابتدا ستونغیر سپسو

د.رامعرفیکنیترسیمشدهمیلگرد

کپینمایید.موردنیازیهادهانه(مهاربندهایتولیدشدهدرایندهانهرابهسایر4






